Using tools to help your research
ACM Digital Library, IEEE Xplore, Refworks

Teesside University
Library & Information Services
RefWorks is a web-based tool that allows you to create and manage your own personal database of useful references. You can then use these to quickly compile a bibliography for your reports and papers.

There are three parts to using RefWorks:

A. **Adding and collecting together references into your account**
   The main ways to build up your collection include:
   1. Exporting from an online database, for example from ACM Digital Library, IEEE Xplore.
   2. Searching from the online catalogues within RefWorks.
   3. Adding records manually.

B. **Managing and organizing your references.**

C. **Creating a bibliography**

This workbook will take you through the basics of these three aspects.

---

**Table of Contents**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task 1</td>
<td>Accessing and registering with RefWorks</td>
<td>2</td>
</tr>
<tr>
<td>Task 2</td>
<td>Searching ACM Digital Library and exporting to RefWorks</td>
<td>4</td>
</tr>
<tr>
<td>Task 3</td>
<td>Searching IEEE Xplore and exporting to RefWorks</td>
<td>8</td>
</tr>
<tr>
<td>Task 4</td>
<td>Editing your references</td>
<td>10</td>
</tr>
<tr>
<td>Task 5</td>
<td>Using folders</td>
<td>11</td>
</tr>
<tr>
<td>Task 6</td>
<td>Creating a bibliography from a set of references</td>
<td>12</td>
</tr>
<tr>
<td>Task 7</td>
<td>Using Write-n-Cite</td>
<td>13</td>
</tr>
</tbody>
</table>

**Additional Exercises**

| Task 8 | Adding a reference manually                       | 15   |
| Task 9 | Using RefGrab-It                                  | 16   |
| Task 10| Exporting from Google Scholar                      | 19   |
| Task 11| Searching the Online Catalogues                    | 21   |
| Task 12| Exporting more than one record at once from ACM Digital Library | 22   |
| Task 13| Adding attachments                                | 23   |

**Help**                                                                 | 24   |
Task 1: Accessing and registering with RefWorks

- Go to the RefWorks page on the L&IS web site (http://lis.tees.ac.uk/refworks).

- Click on the link to ‘Connect to RefWorks’.

  If this page appears - select the option to login via Shibboleth. (It will normally appear when you are off-campus.)

- From the pull-down ‘Institution’ menu select Teesside University and then Login.

- Enter your ICT account username and password into the box on the following page and then login.

- The first time you login to RefWorks there are some details you will need to fill in.

- Then click on Create Account.

- Once you have done this you should automatically go through to an empty RefWorks account page:
Keep this window open as you will be coming back to it in the exercises.
Task 2: Searching ACM Digital Library and exporting to RefWorks

ACM Digital Library forms part of the ACM portal. It provides access to the full-text of articles from journals and conferences published by the ACM (Association of Computing Machinery) including the SIGGRAPH series. The ACM portal also includes the ACM Guide to the Computing Literature which has over 750,000 references from books, journal articles, conference proceedings and other publications.

(ACM Digital Library factsheet - http://lis.tees.ac.uk/factsheets/fs65.pdf)

- Go to http://tees.libguides.com/computing
- From the Computing LibGuide page go to the Finding Papers tab.

- In the Useful Databases section you will see some databases listed - click on the link to ACM Digital Library.
- To perform a Basic search type a word (e.g. occlusion) or phrase (e.g. “ambient occlusion”) in lower case into the text box at the top right of the screen. Phrases should be enclosed in quotation marks (“ “). Then click on Search.
• Your results will now be displayed:

You can further refine your search with these options on the left.

You can also change the sort order of the results. For instance try to re-sort these results by citation count.

To see the full-text – open up the pdf file.

• Click on the title of an article to see further details:

Dynamic ambient occlusion from volumetric proxies

Real-time applications require simple techniques that enable predictable high performance rendering, but illumination methods for GPUs tend either to be complex and fragile on the one hand or very limited and offering poor visual quality on the other. The addition of a plausible global look to an application lighting impacts users’ perceptions of its realism and the spectrum of existing approaches, screen space ambient occlusion (SSAO), is at the simplest and most prediction. We have extended screen space ambient occlusion by replacing its depth buffer computations with a sampling of a volumetric pre-integration of the scene, while still evaluating it in an image-space post-process and thus retaining its predictable performance. We show improvements in quality over depth buffer based alternatives at a reasonable additional cost.

Click on these tabs for further information and investigation.
• We will now export the details of this article into RefWorks:

• In the **Tools and Resources** box to the right of the record click on **BibTeX**

• **Highlight** the text in the box and **copy** it

```
@inproceedings{Cox2010:DAG:1836845.1836978,
  author = {Cox, Andrew and Funtsch, Ben},
  title = {Dynamic ambient occlusion from volumetric proxy},
  booktitle = {ACM SIGGRAPH 2010 Posters},
  series = {SIGGRAPH '10},
  year = {2010},
  isbn = {978-1-4503-0393-8},
  location = {Los Angeles, California},
  pages = {124:1–124:2},
  articleno = {124},
  numpages = {2},
  url = {http://doi.acm.org/10.1145/1836845.1836978},
  doi = {http://doi.acm.org/10.1145/1836845.1836978},
  acmid = {1836978},
  publisher = {ACM},
  address = {New York, NY, USA},
  keywords = {ambient occlusion, global illumination, volumetric},
}
```

• Now return to your RefWorks account:

• To transfer these details into RefWorks we have to import them.

• From the **References** pull-down menu select – **Import**
1. Make sure that the From Text section is open – click on the arrow to open it.

2. For the Import Filter/Data Source select **BibTeX**.

3. For the Database select **ACM Digital Library (BibTeX format)**.

4. Paste (Ctrl V) the details that you’ve just copied into the box.

5. Click on **Import**.

• Click on **View Last Imported Folder** to see the reference in your account.

Every time you import into RefWorks the records will go into the **Last Imported Folder**. To see all your records click on **References** in the breadcrumb trail or use **View – All References**.

**Tip!**
Task 3: Searching IEEE Xplore and exporting to RefWorks

IEEE Xplore provides access to nearly one third of the world's current electrical engineering and computer science literature, featuring high-quality content from the IEEE as well as the UK's Institution of Engineering and Technology (IET)

(IEEE Xplore factsheet: http://lis.tees.ac.uk/factsheets/fs45.pdf)

- This time click on IEEE Xplore
  Enter some key-terms into the Search box.

You can further refine your results with the options on the left.

From the results list select any items that you want to export to RefWorks by clicking in the tick box by that item.
• Your records should automatically be imported into RefWorks.

Word of caution:
When you export records, RefWorks will open up in a new window each time. If you already have RefWorks open that will also remain open – i.e. you will have two windows open displaying your RefWorks account. One of these will be the previous version without the items you have just attempted to export. You will need to close this window down to keep track of your references.

In the list of useful databases, if there is a by the database name this will link you to a page that will show you how to export into RefWorks.
Task 4: Editing your references

RefWorks doesn’t write the information – it only reads it. It’s important to check your references to make sure the information is correct and conforms to the output style you will use for your bibliography. You may need to edit the information in a record if there are any errors.

Open up one of your records that you exported from ACM Digital Library. (Close down any boxes by clicking the X in the top-right corner. Use the breadcrumb trail to go back to all your references).

With ACM records the journal title is only exported in an abbreviated form and you will need to go into the Edit page (the pencil icon) and add the full-title details into the Periodical, Full field.

Click on the pencil icon to get to the edit screen

Amend the appropriate section

Then click on Save Reference
Task 5: Using folders

You can organise your references into useful sections called folders. You can name and set these up yourself.

1. Click on the ‘New Folder’ button.
2. Enter a name in the New Folder Name box (e.g. ICA)
3. Click on ‘Create’.

Now that you have set up a folder you can put references into it:

1. From the View pull-down menu, select ‘All References’.
2. Mark any desired references, by clicking in the check box to its left.
3. Make sure the Selected button above the references is selected (or if appropriate the Page or All in List option) (see 1 in screen-shot below).
4. Select a folder from the Add to pull-down menu (2 in screenshot below).

There is no limit to the number of folders that you can create.

References can be assigned to more than one folder.

You can also create subfolders within folders.

If you are manually selecting records, you will need to work through the references one page at a time when adding them to folders.
Task 6: Creating a bibliography from a set of references

1. Click on the ‘Create Bibliography’ button.

2. Select the Output Style you require (e.g. Teesside University: SCM – a specific style set up for the School of Computing)

3. Within the ‘Format a Bibliography from a List of References’ section:

4. Select the File Type (e.g. For a Word document choose Word for Windows).

5. From the References to Include section:
   Select the relevant option to retrieve your references (e.g. All References, or a specific folder).

6. Click on ‘Create Bibliography’ (bottom right).

7. A new window will open with your bibliography (you may need to click on a link at the top of the page for the file to be downloaded).

8. This will be a normal Word document and can be treated as such. Save your bibliography.
Task 7: Using Write-n-Cite

This facility allows you to cite references in an assignment with a click of a button whilst using Microsoft Word and then to compile a bibliography from those references you have cited. It works for users accessing RefWorks using Windows and Internet Explorer (there is also a version available for Mac users).

In order to use this feature, you have to download the Write-N-Cite utility. This should automatically be loaded onto university computers, but off-campus you will have to download a small program on to your PC. This can be found in RefWorks under the Tools pull-down menu and selecting **Write-N-Cite**. Follow the online instructions to load the utility program. There are a number of versions, so check that you download the one that is most compatible with your PC. The most recent version is version III and this is compatible with MS Vista/Windows 7 and Word 2007/2010. The instructions that follow apply to this version.

**How to use Write-N-Cite**

1. Open up a blank Word document.

2. To open up ‘Write-N-Cite’ from a University PC go to the Start menu and select it from beneath RefWorks in the list of Programs.

3. Log in to the Write-N-Cite utility using your ICT username and password. Select the option to ‘Login through your institution (Shibboleth users)’.

4. Write an introductory sentence e.g. this research provides details of ambient occlusion

5. With your cursor positioned within your Word document at the end of your first sentence—click ‘Cite’ next to a reference in the ‘Write-N-Cite’ page.
6. If you switch back to your Word document now you will see that ‘Write-N-Cite’ has automatically inserted the reference details as well as some opening and closing curly brackets along with the Ref ID of the item. (These are called **Temporary Citation Placeholders** and will not appear like this in your final work.)

```
{{59 Ganji,D.D. 2010}}
```

7. If you want to modify or remove information that will appear in the formatted citation e.g. add a page number, click on the blue **Edit Citation** link in the upper right-hand corner of the Write-N-Cite window. (Make sure you **Save to Word** any changes that you have made.)

8. Carry on adding citation placeholders into the Word document.

When you are ready to create a bibliography:

9. Click on **Bibliography** from the toolbar on the Write-N-Cite window.

10. Select the output style you would like to use e.g. Teesside University: SCM from the **Output Style** drop down menu.

11. Click on **Create Bibliography**.

12. The program will format your document with the in-text citations and a bibliography.

13. If you want to revise your paper and add additional temporary citation placeholders, simply add the new citation placeholders in the appropriate spot(s) to your document and reformat your paper (using the **Bibliography** option). The newly added references will be formatted and the bibliography will be updated.

---

Please see the **School Guidelines** for advice on how you should present a bibliography - [http://lis.tees.ac.uk/referencing/scm.pdf](http://lis.tees.ac.uk/referencing/scm.pdf)
Additional exercises

Task 8: Adding a reference manually

There are some databases from which you are unable to export information. In these instances you will need to add the information in manually.

1. From the References menu – select Add New. (or alternatively click on the New Reference button)

A new window will open up:

Use the following reference as an example and add this into your RefWorks account:


(Input all 4 authors: Grottel, S.; Reina, G.; Dachsbacher, C.; Ertl, T.)

2. Select a Citation Style from the View fields used by: (e.g. Harvard). Select a Ref Type that is appropriate for the resource you are adding (e.g. Journal Article) You can then add the information to the relevant sections in the form. Click on Save Reference at the bottom of the form.
Task 9: Using RefGrab-It

RefGrab-It works with your browser to capture bibliographic information directly from webpages. It gives the option to import that data into your RefWorks account.

It works particularly well if the page includes an ISBN or a DOI (used with journal articles). It doesn’t work with pdf documents however – these will need to be added manually.

1. You will need to initially download RefGrab-It.

2. From the Tools area (in RefWorks), select RefGrab-It

3. You have the choice of installing RefGrab-It as a Plug-in or as a Bookmarklet. Please also note there are different versions for Internet Explorer and Firefox (RefGrab-It is not currently compatible with Google Chrome).

To download the Bookmarklet in IE:
17

(This may vary according to the version of IE you are using)

1. You will need to turn off pop-up blockers through Tools – Pop-up Blockers on your browser.

2. Right-click on the RefGrabIt link in the Bookmarklet section.

3. From the menu of options select Add to Favourites

4. Click on Yes to the security challenge message you may get.

![Image of RefGrabIt installation process]

Click on Add – this will add RefGrabIt to your favourites list.

Example of its use:

- Go to a web site e.g. http://developer.nvidia.com/

- At the page showing the details of the book click on RefGrab-It in your Favourites or Links toolbar. (For the Links toolbar - you may need to right-click on the >> at the far right of the toolbar and select it from the options that should then be displayed.)

- You may now get a cream security banner appearing about pop-up blockers – set to allow them from this site. You will now need to go back and click on the RefGrab-It link again.

- A RefWorks page should now appear showing the details of the web page, select the reference then click on the Import to RefWorks button.

[Diagram of RefGrabIt bookmarklet process]
• The reference will be automatically imported into your RefWorks account.

• Click on the View Last Imported button to see the reference.
**Task 10: Exporting from Google Scholar**

You are able to export directly from Google Scholar into RefWorks.

1. Go to Google Scholar - [http://scholar.google.co.uk/](http://scholar.google.co.uk/).
   Firstly you need to, however, set up RefWorks in the **Scholar Preferences** area.

   Go to the **Scholar Preferences** section:

   ![Scholar Preferences](https://example.com/scholar_preferences)

   Click on **Scholar Preferences** from the pull-down menu in the top-right of the screen.

2. Scroll down to the bottom of this page.

3. Under **Bibliography Manager** select the ‘**Show links to import citations into**’ and select RefWorks from the pull-down menu.

4. Then click on **Save Preferences**.

5. Now when you do a search in Google Scholar your results should appear like this with the option to Import into RefWorks.
6. Click on the link to ‘Import into RefWorks’ by anything you would like to add to your RefWorks account.

7. In RefWorks click on the button “View Last Imported Folder” button (bottom right).
Task 11: Searching the Online Catalogues

RefWorks can be used to search a number of online resources such as the Teesside University Library Catalogue, The British Library Catalogue and many other university library catalogues. This can give you an easy way to import details of items you wouldn’t normally find in online databases, especially books.

1. In RefWorks - from the ‘Search’ drop-down menu, select ‘Online Catalog or Database’.

2. Select a database to search from the ‘Search’ drop-down menu (e.g. Teesside University)

3. Select the ‘Max. Number of References to Download’ from the drop-down menu (You would normally be using this search to look for a specific title that you want to add to your RefWorks database).

4. Enter search terms in either the ‘Quick Search’ or ‘Advanced Search’ sections.

5. Click on ‘Search’ (at the bottom right) to begin your search.

6. Select the reference(s) you would like to import into your RefWorks account and click on ‘Import’ (at the bottom right). Then on OK.

7. Your selected reference(s) will be imported into your account.
Task 12: Exporting more than one record at once from ACM Digital Library

An alternative way to import a set of references from ACM DL is to:

- Paste the information from the BibTeX window into a Word document / or notepad.
- Repeat the display and copy/paste for other articles of interest.
- Save the document as a text file (.txt)

- Return to your RefWorks account
- From the Reference pull-down menu select Import.

1. Make sure that the From Text File section is open

2. Select BibTeX

3. Select ACM Digital Library (BibTeX format)

4. Browse for the file you have saved and open it to here.

5. Click on Import

Click on View Last Imported Folder.
Task 13: Adding attachments

RefWorks allows you to attach a file to your RefWorks record. This could be for instance the pdf of the full-text of an article or it could be a Word document or image.

To attach a file to your RefWorks record:

1. Locate the appropriate RefWorks record and go into the Edit page (the pencil icon).

2. Click on Browse and locate a file you’ve saved previously. Then click on Add attachment.

3. A link to the document will appear in your record.

4. Click on Save Reference. You will now see a paperclip icon by that reference which denotes it has an attachment.
Help

There is a lot of further help available:

From Library & Information Services:
  • Please contact Sue or Patricia for further help.

  Sue Myer – s.myer@tees.ac.uk

  Patricia Crosier – p.crosier@tees.ac.uk

From within RefWorks:
  • From the Help menu there are link to Tutorials and help-pages

Useful links:
  • SCM School Referencing Guidelines -
    http://lis.tees.ac.uk/referencing/scm.pdf

  • LibGuides referencing page –
    http://tees.libguides.com/content.php?pid=239827&sid=1978955

  • DISSC referencing web pages -
    http://dissc.tees.ac.uk/references/Content.htm